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Macintosh Version

Installation Procedure
1. Insert the Tabletop diskette into your floppy drive.
2. Double-click the icon labeled “Installer.”

3. The installation procedure creates a folder called “Tabletop.” The default location for
this folder is at the top level of your startup disk. If you wish to specify a different
location, click the button at the bottom of the screen labeled “Select Target Folder.” A
standard Save File dialog lets you choose a different location in which to put Tabletop.

4. Click the button labeled “Install.”

After completing the procedure, run Tabletop by double-clicking the Tabletop icon inside
the Tabletop folder.

Notes

The Tabletop folder occupies a little less than 2 megabytes of disk space. It contains:

e The Tabletop application
*  The file “TTHelp” which is used by Tabletop’s on-line help facility.

e Afolder called “Tabletop Data,” containing sample databases, sample Tabletop plot files,
and empty database templates.

You may choose to copy the Tabletop Data folder or move it from the Tabletop folder.
The other files should remain together as installed.

By convention, files in the Tabletop Data folder have names ending in “.db" if they are
databases, or “.tt" if they are Tabletop plot files.

If you have previously installed Tabletop, and you need to reinstall the application or the
data files, but not both, you can choose “Custom Install” instead of “Easy Install” from the
pull-down menu at the top of the Tabletop Install dialog. Select the target folder as before;
then check the module you want to install.
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Windows Version

Installation Procedure
1. Insert the Tabletop diskette into your floppy drive.
2. From the Windows File Manager, run the program called SETUP.EXE.

3. A screen called Tabletop Setup appears, with three buttons at the bottom, labeled
“Continue,” "Exit,” and "Help."” Click “Continue.”

4. The Installation Directory screen appears. Now specify where Tabletop should be
installed. The default location for the files is [ Windows Drive ][N\TABLETOP. [f this is
where you want to install the files, simply click “Continue.” Otherwise, type a different
pathname, and then click “Continue.”

After completing the procedure, run Tabletop by double-clicking the program item
Tabletop inside the program group Tabletop.

Notes

The installation procedure creates a directory called TABLETOP which occupies about
2.5 megabytes of disk space. It contains:

* The application program TABLETOP.EXE, five .KIT files, and the file TTHELP, which are all
part of the software

* A directory called TTDATA containing sample databases, sample Tabletop plot files, and
empty database templates.

You may choose to copy the TTDATA directory or move it from the TABLETOP
directory. All other files should remain together as installed.

Files in the Tabletop Data folder have the extension .TDB if they are databases, or . TT if
they are Tabletop plot files.

© 1995 TERC. All rights reserved.
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INTRODUCTION 1

NANANANANANANANANANAN

Tabletop is an easy-to-use, inviting visual tool for storing,
exploring, and analyzing data. Whether the data describe world
capitals, chemical compounds, geometric figures, or insects,
Tabletop provides an animated, interactive environment in which
you can group, rearrange, sort, and compare data. At the click of a
button, you can put the data into a graph, change the parameters
of the graph, and watch the data (in the form of icons) move across
the computer screen to illustrate the results.

Tabletop's accessibility and power allow novices and younger
students to get started quickly with meaningful data analysis. For
more advanced users, Tabletop's special strength is in flexibly
exploring and representing the interaction of many variables, both
numerical and categorical.

The Tabletop software has two main components: a database
window into which data are recorded; and a tabletop window that
represents data as icons. The icons can be organized in different
graphs or plots. Three kinds of plots — Venn, Stack, and Axes —
arrange the icons based on rules that you define.

Tabletop includes many features to facilitate thinking,
communicating, and data management. Some examples are:

e quick and easy editing of constraints and axes
¢ Plot History and Slide Show features for saving plots
¢ Annotation features for documenting data and plots

¢ color Icon Editor and Icon Library for customizing the
appearance of data records

¢ [con Marking facility for highlighting points within a graph
¢ data import and export

¢ powerful Join facility for combining databases

Macintosh and This manual describes both the Macintosh and Windows versions

Windows Versions of Tabletop. If you are using the Windows version, your screen will
sometimes look slightly different from the illustrations in this
manual. However, the software behavior and controls are the same.

© 1995 TERC. All rights reserved.




The database window shows the data
in rows and columns. The database
might be one that you create, or that
comes from another source. This
database of cats comes from the
Used Numbers curriculum.

In a tabletop window, records appear
as movable icons, which are initially
scattered randomly. Double-click an
icon to see its detailed information.
Icons can be labeled with any
information in the database.

& Lady Jone Grey | , 11l yelinw
&  Histy i1 ioreen
4  Tomonochi '

&  Alesender

&  oddruze

&  Strawberry 10 | green

fats] Tablntop §

&(Genrge ‘f‘“"»‘m’d

‘;Peau de Boie

Rave T Ei
&( Alexander &Katenka ixi.aﬂg ‘! l"* oraonochi

;‘jStrawberrg ‘flaﬂg +Jane Brey i;l”hﬁens
name @

age & odonuze

‘;’&'eam

eye color: & o
pad color:
' &(Pepper

tail length:

'From "Statistics: Prediction and Sampling” by R. B. Corwin and S. N. Friel, 1990. Used Numbers: Real Data in the Classroom.
Palo Alto, CA: Dale Seymour Publications. Copyright 1990 by Dale Seymour Publications. Reprinted by permission.
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Tabletop's Venn plot is useful for
searching and grouping the data. Icons
move in or out of loops automatically,
to satisfy the constraint you specify. & ononoont

e Meé’; e

=
3=
>

A Venn plot with three intersecting

loops.

gresn

& naonee
i,rl“leh‘ssa

& rittens
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Use a Stack plot to look at the

distribution of one variable.

In Tabletop’s Axes plot, the icons can
arrange themselves to produce a scatter
plot. As always, if a particular icon
looks interesting, its detailed
information is available with one

double-click.

[Cats] Tabletop 1

nome :

sex:

age:

weight:

body length:
tail length:
eye color:
pad color:
full length:

body length | :
A R [
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Another form of the Axes plot features

box-and-whisker overlays.

Tabletop can show summary
computations (counts, averages, totals,
eic.) — instead of icons — for the
groups of records in each region of the
plot. Here, the result is a cross
tabulation. This figure also shows
Tabletop's facility for annotating any
plot and for saving plots in a “slide
show"” that can be replayed later.

© 1995 TERC. All rights reserved.

[Cats] Tabletop 1

&
i - ‘jatrawbe-frg ‘;'ﬁ’nt‘g
Ravena

& oo
‘gﬁiv‘a ‘,M Jissa

Hittens

& peblee s l%fgﬁmg Kithy

Jane Grey
‘;Tigger
&

[Cats] Tabletop 1 ¢

aije color

L
black pink and black

pad coior|

This crosstabulation suggests a possible tendency for green-eyed cats to
have black paws pads, and yellow-eyed cats to have pink paws.
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QUICK REFERENCE

NANANANANANANANANANAN

The Database Window

Drag the field name

right or left to
Click to cancel rearrange the order Field headings: Click
text editing. of the columns. to select the field.

Click to accept
text editing.

Default icon: Click to
select; double-dlick to edit.

Record icons: Click 9.012182

to select entire
record; double-click
to edit custom icon. 140067

20.1797 | -248.59 |

Drag to split Click in any cell to edit. The
the window. contents are displayed in the
box above.

Database Window with a Field Selected

Click the arrow to change the field type:
Field name: String (a,b,c), Number (#), or Boolean (T/F

edit here. or Y/N); or to enter a formula. Annotation

area

2 | Helium 4002602 |

© 1995 TERC. All rights reserved.

Click to open the
annotation area.

Click to open the
tabletop window.

Drag to resize the
annotation area.

2,472

-195.8

-246.08 | nonm

Scroll to see more.

Using the keyboard
to move around

ARROW KEYS: Move left, right,
up, or down

TAB: Move right, or to the
beginning of the next line

SHIFT+TAB: Move left, or to
the end of the previous line

RETURN: Move down

38+ TAB, 38+RETURN:
(Macintosh only)
Move right or down,
creating a new record or
field if necessary




File Menu

Edit Menu

Database Menu

Creating Databases

New Database
New Tabletop
Open...

Close <name>
Save <name>

Save As...

Revert to Saved
Color Windows

Page Setup...

Print...

Quit

Undo

Cut

Copy
Paste
Clear
Copy lcon
Edit Icon

Add Record
Add Field
Delete

Field Format...

Fat Rows

Database Annotation

Questionnaire...
Sort...
Join Databases...

To create a database:

Create a new database

Create a new tabletop window

Open an existing database or tabletop window
Close the database or tabletop currently open
Save the database or tabletop currently open
Save the database or tabletop under a different name,
in a different location, or with a different format
Return to the last saved version

(Macintosh version only.) Draw windows in color or
black and white (The Windows version of Tabletop
always uses color.)

(Windows: Print Setup) Set the size and orientation
of the page for printing

Print the current database or tabletop

Close the Tabletop application

Reverse the last change to the database or tabletop
Delete the selected item (value, record, or field)
Copy the selected item (value, record, or field)
Insert an item that has been cut or copied

Delete contents of the selected item

Copy the icon when a record is selected

Open the Icon Editor when a record is selected, or
when the default icon is selected

Add a new row at the bottom of the database
Add a new column at the right of the database
Delete a field or record

Specify display format for numeric or Boolean data
in the selected field

Enlarge rows to accommodate large icons

Open an annotation area and show the database
annotation

Open a questionnaire-like form for data entry
Order records alphabetically or numerically
Combine data from two or more databases

1. Choose New Database from the File menu

2. Type a name for the first field, click V.

3. Use Add Field from the Database menu to add more fields; give

each field a name.

4. Enter data in the first record.
5. Use Add Record from the Database menu (shortcut: 38-R) to

add more records.

6. Save the database in a file.

Tabletop User's Manual



The Tabletop Window

Venn Loop Plot

Click to close
this loop.

Click to add
another loop to
the Venn plot.

Click for Yenn plot.

Click for
Stack plot.

Stack Plot with the
Plot Recorder

Numbers show about
how many icons are
in columns of
different heights.

Click to specify the
minimum value for
the axis.

Click to specify the
step between intervals.

Axis Edit bar: Show
or hide this from
Tabletop menu.

Click to choose categories, ranges,
or continuous data for the axis
(but note that continuous data
are not allowed in Stack plots).

Double-click an icon to see its
data; dick again to close the
data window.

Loop constraint: Click a
part of the constraint to
change it.

Click to select all icons
within this region of the plot.

eye color:
pad color:
full length:

Click to select the
field for icon labels.

Click for Axes plot. Select summary computation

(count, total, mean, etc.).

Open plot
annotation area.

Select field for

Turn labeling on
summary computation,

or off.

Tumn summary
computations on or off.

N

&
e

Specify loop constraint:
—Select a field

—Select a comparison
(=, >, contains, etc)

—Specify a cutoff or
comparison value

Bring database
window forward.

ats with furl Tabletop

s
&
&
&
&
&
&
&

Click to select a field
or formula for the axis.

Click to select lower
or upper bounds for
axis intervals.

Click to reset axis
limits and step values.

Click to specify a number to

© 1995 TERC. All rights reserved.

Plot recorder (including
history and slide show): Show
or hide this from the
Tabletop menu.

Click to recall a plot
from the plot history.

Scroll through plot history
{up to 30 plots).

Click to recall a plot
from the slide show.

Click to store the
current plot in the
slide show.

be induded in the top range.




Axis Plot

Tabletop Menu

Click to edit the
upper limit.

Click to select a field or
formula for the Y-axis.

Click to edit the lower
limit for this axis.

Click to select a field or
formula for the X-axis.

Axis Edit bar:
Show or hide this from
the Tabletop menu.

Click and drag in "gutter"
near axis to select a band

across the plot.

No Data

Click to select continuous,
categories, or ranges for this
axis.

Marking...
Unmark All

Label Selected Icon
Show/Hide Annotation
Show/Hide Axis Edit Bar
Show/Hide Plot Recorder

Half-Size Icons
Clear History

Clear Slides

3

Install New Database

View Constraint...

Box Plot
Box Plot Options...

nanfrnetatlic

Click to reset axis to default
limits and ordering.

Choose Box Plot in the
Tabletop menu to add or
remove box-and-whisker
overlays.

Click and drag to select
a region within the plot.

[Element.db] Tabletop

=P
ST TRRE )

—_—

metallic sernimetallic

matallic? |

To change category order, dick
and drag a category name.

Mark selected icon(s) with color and/or a box
Remove colors and boxes from all marked icons
Add a field label to selected icon(s)

Show or hide the tabletop annotation area
Show or hide the Axis Edit bar

Show or hide the Plot Recorder

Reduce the size of icons by 50%

Clear plots in the History selection of the

Plot Recorder

Clear plots in the Slides section of the

Plot Recorder

Look at another database in this tabletop window
Specify a subset of the database to view in the
tabletop window

Add a box plot overlay to an Axes plot

Specify options for a box plot display

Tabletop User's Manual



lcon Editor To use the Icon Editor:

In the database window, double-click the icon you wish to edit.

Select an icon from the Icon Library or make your own using
the color palette.

Click OK to make the changes or click Cancel to close the
Icon Editor without accepting the changes.

Indicates whether you are editing a custom N . .
icon for one record, or the default icon for lcon editing area: Click to edit

all records.

Custom lcon - cats with fur

Actual size and
look of this icon.

BE
Color palette: .

Click a color to

select it for drawing. .
u -

the icon one pixel at a time.

Library lcon Library: Click
an icon to select it.

Click these arrows
to see other icons

Click to clear
the edit window.

Clear | [Default] [ Copy | [ Paste |

in library.

Click to put a library
selection into the icon
edit window.

Click to revert to Click to use the default icon Click to copy this icon Click to paste an icon
the original icon. (in the upper left corner of to the Clipboard. from the Clipboard.

the database).

© 1995 TERC. All rights reserved.




Joining Databases To join databases:

1. Choose Join Databases from the Database menu.

2. Click and drag the black triangle [# to select the databases to
be joined.

3. Click and drag the field tiles to line up corresponding fields.

4. Click Append to add records with similar fields to the bottom
of the database.

OI‘:

Click Merge to add new fields of data to existing records.

Field tiles:
Click to append all data  Click to merge data into Click to clear all the Click and drag these to
into one new database.  one new database. databases and tiles.  Field names. match fields.

Click and drag the
black triangles to
select databases.

Tabletop User's Manual




The Formula Language
Field Names

Computing with Numbers

Computing with Strings

Computing with Booleans

Other

Conditionals

© 1995 TERC. All rights reserved.

Put field names in single quotes (e.g., first name') unless the field
name has no spaces or special characters, and does not begin with a

numeral (e.g., age). Abbreviations will work as long as they are
unambiguous (e.g., first).

atb
a*b
—-a
adivb
a’b
a=b
a>b
a>=b
abs(a)
round(a)
ogfa)
log(a,b)
In(a)

min(a,b,c,...)

a=b
a/=b

a contains b

a=b
aand b

not a

valid(a,b,...)

if...Then...Else...
Iif...ls...

addition

a times b
negative of a
integer division
ato powerb
equal

greater than
greater than or equal
absolute value
nearest integer
log a base 10
log abaseb
log a base e

smallest value

equal
not equal

contains substring
equal
logical and

logical negative

test for valid data

e.g., If temperature <= 32 Then "freeze” Else “thaw

a-b
alb

fa
amod b

al=b
a<b
a<=b
sqrt(a)
sin(a)
cos(a)
tan(a)
string(a)

max(a,b,c,...)

length(a)
concat(a,b,...)

number(a)

al=b
aorb

string(a)

aminus b
a divided by b
reciprocal of a

remainder

not equal

less than

less than or equal
square root

sine

cosine

tangent

convert to string

largest value

count characters
concatenate

convert to number
not equal

logical or

convert to string

e.g., If month Is 2:28, 4:30, 6:30, 9:30, 11:30 Else 31
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DATABASE BASICS 3

NANANANANANANANANANAN

Database, Record, and
Field

© 1995 TERC. All rights reserved.

Tabletop is a tool for working with databases. Information in a
database is organized in records and fields. A record is a collection of
associated information about something; a field is a cross-section of
parallel information about each record.

A telephone book is a good example. Each listing in a phone

book — with information such as last name, first name or initial,
address, and phone number — is a record. “Last Name,” “Address,"
and “Phone Number" are all examples of fields. In a phone book,
records appear as rows, and fields appear as columns. A single piece
of information, such as a phone number, is contained in a cell — the
place where one record and one field intersect.

Milot Ann 3 Columbia New ...............cccoiciiinnnnnnna. 423-3063
Milstein Phil 2 Green Som ..........cccooooiieiieen . 354-0023
Milton Jos 4 Inman Cam ............cc.oooeeiieeieeneen . 492-7130
Mimi’s Oriental Grill 230 Maschsts Ave Cam ........ 577-7773
Min Soo Toug 5 Newton Som ..............ccccociiieeee 623-0022

The record-field structure of the phone book is something we
depend on. We would have difficulty using a phone book in which
people’s first names sometimes appeared in the place where last
names go, or in which one person's phone number appeared next
to someone else’s name. When you use the phone book, you search
the “Last Name" field for the desired name. You might also check
the "First Name" field and the “City” field until you find a record
that matches the person whose number you require. Then you find
the phone number in the "Number" field.

In Tabletop, all the fields, records, and cells of a database are
presented in the database window. The sample database shown on the
next page contains information about chemical elements. You can
explore this database on your computer by opening the file
Periodic.db (Windows: Periodic.tdb) from the data folder that is
installed with the Tabletop software.




The Database Window Each row is a record with information about one chemical element:
all the information about Helium, for example. Each column is a
field with parallel information about every element: all the atomic
weights, for example. At the left of each record is an icon (a small
shape or picture) that stands for the record in graphs and plots.

Field

i Periodic.db

Default Icon

Record

4,002 | nonmd
lcon

Horizontal
Split
Control

Magnesium 1,090

Selecting a Cell Scrolling

SGI'OIIiﬂg and Selecfing Two basic operations you can use in the database window are

scrolling and selecting.

Scrolling Many databases have more information than can be displayed at
once in the database window. Whenever this is true, the database
window shows a portion of the database at a time. To see records
that are beyond the limits of the window, use the vertical scroll bar
to bring them into view. To see fields that are beyond the limits of
the window, use the horizontal scroll bar to bring them into view.
You can also make more data visible at once by enlarging the
database window. (For information on using scroll bars and resizing
windows, refer to the documentation that came with your
computer system).

The split scrolling feature is useful for bringing two distant fields
into view at the same time. Drag the horizontal split control to the
right to open a second, independently scrolling area in the
database window. Now you can keep some fields (such as element
name) in view in one scrolling area, while you scroll through other
fields in the other scrolling area.
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In the database window you can select four kinds of objects:
records, fields, cells, and the default icon. Selecting an object

is a way to single it out for manipulation. When you want to
copy, cut, replace, edit, modify, or inspect an object, begin by
selecting it. When an object is selected it becomes visually

highlighted.

e To select a record, click the icon at the left of the record.
e To select a field, click the heading at the top of the field.
e To select a cell, click in the cell.

e To select the default icon, click the small icon in the upper
left of the database window.

Y
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BUILDING A DATABASE 4
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Overview This chapter describes how to work with a database in the
database window, including all the information you need to build a
new database. It covers how to:

® open a database
e print a database
® save a database
® close a database

® create a database

¢ add a new field

® name a field

e define a field type
¢ delete a field

e format a field

® resize a field

® move a field

¢ addarecord
e delete a record

e duplicate a record

® enter data

e edit data

¢ cancel and undo data entry

¢ use the Questionnaire to enter data

e use the Edit menu

Open, Print, Save,
Close, Create Databases

Open a Database To open an existing database, choose Open from the File menu
and follow your computer system’s standard procedure for opening
a file. If you are using the Windows version, Tabletop database
files have the extension .tdb.

You can have more than one database open at a time.
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Print a Database

Save a Database

Close a Database

Create a Database

To print your database, select Print from the File menu.

When there are more fields (i.e., columns) than fit on the page,
Tabletop breaks the printout onto multiple pages. In some cases,
you may want to set the printing orientation to landscape mode to
fit more fields (but fewer records) on a single page. To use the
landscape mode, choose Page Setup (Windows: Print Setup) from
the File menu, and follow your computer’s standard procedure for
setting the page orientation.

To save your database in a file, choose Save from the File menu.
(Make sure the database window is active when you do this.)
Follow your computer system’s standard procedure for saving files.

To save a copy of your database in a new file, choose Save As from
the File menu.

The Save operation stores your database as it appears in your
database window; it does not save plots or graphs you have made
in a tabletop window. Choose Save Tabletop from the File menu
(see page 68) to store the contents of a Tabletop window in a
separate plot file.

Tabletop normally stores data in its own file format. To facilitate
exchange of data with other programs, Tabletop can also save data
in a text file. See "Exporting Data,” page 38.

To end work in your database, choose Close Database from the File
menu. A dialog box appears if you have made any changes since
you last saved your database. Choose Yes to save the changes and
close the database; choose No to close the database without saving
the changes; choose Cancel to keep the database open.

To create a database, choose New Database from the File menu.
A new database window opens:

New Database 1
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Fields
Add a Field

Rename a Field

Define a Field Type
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Tabletop automatically gives this database the default name “New
Database 1." The new database has one field, provisionally named
“Field 1." (Because the field is selected, you can type a new name
for the field, then press RETURN or ENTER.) The database has one
record.

All the options described in this chapter are available to you.
The essential operations for building a database are:

¢ adding new fields and naming them
¢ adding records
® entering data in cells

® saving your database

To add a field to your database, choose Add Field from the

Database menu. Refer to the following sections for naming,
defining, and formatting each new field.

The field is created with a provisional name such as “Field 1" or
“Field 2." For your convenience, a new field is selected when it first
appears. This means that you can immediately rename the field,

if you choose. Type the new name and press RETURN or ENTER
(or click ¥).

To rename a field at any time, select the field by clicking the field
heading. The field name appears in the editing area.

Type a new name for the field. The name can be up to 31
characters long and include any combination of letters, numbers,
special characters, and spaces. (However, shorter, simpler names
are generally more convenient.) After you type a new name, you
have a few options:

e Click ¥ to accept this new field name
e Click X to cancel text you typed

® Press RETURN or ENTER or TAB to enter the new field name
The new field name appears at the top of the column.

The type, or data type, of a field is the kind of information that you
can enter into each field, such as numbers, text, or Boolean (true/
false) values. Each field contains data of just one type.




The Field Type

You do not have to define the data type, because Tabletop can infer
the field type automatically, based on the data that you enter.
However, sometimes you may want to control a field's type
explicitly. When you define a field type, you are making sure that
only the right kind of information is entered in the field. For
example, a field set up for numerical data (such as a population
number) will not accept a text entry. A field's type also affects the
ways that data in the field can be graphed.

To define the field type, select the field by clicking the field
heading. The current field type is displayed in the field type selector.

ew Database 1

Mame

Boolean

Click and hold the black triangle ® that appears in the field type
selector. From the menu that pops up, choose the field type you

want. The options are:

e Number. Whole numbers or decimals can be entered in a number
field. You might use a number field for ages, distances,
population sizes, or to record measurements.

e Siring. Letters and characters, including spaces, can be entered.
Numbers entered into a string field are treated as characters
and have no numerical value — you cannot add or subtract
them, for example. Names, street addresses, colors, or
categorical information such as high/medium/low or north/
south/east/west would all be entered in string fields. Telephone
numbers containing a dash (-) character (as in 444-8292) would
also be stored in a string field.
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Format a Field
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® Boolean. Boolean fields allow only two possible data values: True
or False (these may alternatively be displayed as T/F Yes/No, or
Y/N. See "Format a Field,” below). Use a Boolean field to
answer a question about each record. For example, a database
for a study of sleep patterns might include a string field
representing the date and a Boolean field indicating whether a
person remembered dreaming that night.

o  Formula. Using this option you can specify a way for data in this
field to be computed automatically, based on a formula that
you provide. Formula fields and the formula language are
explained in Chapters 11 and 12.

®  Undefined. If you leave the field type as Undefined, Tabletop sets
the field type automatically, based on the first data value you
enter in the field. For example, if your first entry is 252,
Tabletop changes the field type from “Undefined” to “Number.”

You can change the data type of a field anytime. To do this, select
the field, and choose the new type from the field type menu. Any
data already in the field are converted to the new type, if possible;
data that cannot be converted are lost. For example, if you convert
a string field to a numeric field, entries that look like numbers
(such as “5"), are converted to true numbers; entries that don't
(such as “five") are lost.

If you change a field type by mistake, reverse the change
immediately by choosing Undo from the Edit menu. (You can also
simply change the type to what it was before. This option does not
restore data that was lost in conversion, however.)

To remove an unwanted field from the database, select the field by
clicking the field heading, and then choose Delete Field from the
Database menu.

If you delete a field by mistake, you can restore it by immediately
choosing Undo from the Edit menu.

You can control how the data values in numeric and Boolean fields
are displayed. To do this, select the field you want to format (by
clicking its heading), then choose Field format from the Database
menu.



e  When the field type is Number, this dialog box appears:

Mumber Format:
| (") Floating Format

{3 No Decimal Places
{ One Decimal Place
(" Two Decimal Places

@ Other: |3 Decimal Places

[<] Use Commas between Thousands

Select the format you want, then click OK or press RETURN.

¢  When the field type is Boolean, this dialog box appears:

Display Boolean Values as:

Cancel
@ True/False ) Yes/No

o T/F I Y/N

Select the format you want, then click OK or press RETURN.

Field formats affect appearances only: They do not change the data
that are stored in the database. For example, numbers are stored
internally with about 15 digits of precision, no matter how many
decimal places are displayed.
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Move a Field

Records
Add a Record

Delete a Record

Duplicate a Record

Selecting Multiple Records
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To make a field appear wider or narrower to accommodate the data
values that appear in it, place the cursor over the right edge of the
heading. The cursor changes to a vertical bar with arrows pointing

left and right #. Click, hold, and drag the edge of the field; release

the mouse button when the field name reaches the desired size.

As your database takes shape, you may want to change the order in
which fields appear. To move a field to a new position, click, hold,
and drag the field name horizontally until the cursor is over the
boundary line of another field name. The cursor changes its shape
to an arrow pointing downward 7. Release the mouse button: The
column moves to the new location.

To add records to your database choose Add Record from the
Database menu. Tabletop displays the new record as an empty row
at the bottom of the data table.

To delete a record from your database, select it by clicking the icon
at the beginning of the row. Then choose Delete Record from the
Database menu.

If you delete a record by mistake, immediately choose Undo from
the Edit menu to restore it.

To duplicate a record, first select the record then choose Copy
from the Edit menu. Next choose Paste from the Edit menu. Each
time you paste, a duplicate of the record is added at the bottom of
the database.

Duplicating a record can be useful when you want to add one or
more new records that have data in common with an existing
record. Once you have added the duplicates at the bottom, you
can modify them as needed.

Occasionally you may want to select more than one record at the
same time — in order to delete or copy several records at once or
to change all their icons at once. To select multiple records one at a
time, hold down 38 (in Windows, hold down cTRrL) and click the
mouse repeatedly to add and remove records from the selected
group. Or, to select a whole series of records, click the first record
in the series, then SHIFT + click (i.e., hold down shift while you
click the mouse) the last record in the series: All records between
these extremes are selected.




Entering and Editing
Data

Entering Data

Editing Cells

Canceling and Undoing
Cell Editing

The rectangular space that is formed where a field and a record
intersect is called a cell. You can enter data into any cell in the
database. First, select the cell by clicking in it (or by using TaB,
RETURN, or other keyboard shortcuts; see p. 7). The cell highlights,
and a rectangular box called the edit area, appears at the top of the
database window.

Edit Area

12 | Crazy Eights

Type the data you wish to enter in the cell. Your typed entry
appears in the edit area. Next, to store your entry in the selected
cell, press RETURN, ENTER, TAB, or click the \ box left of the edit
area. The information that you type appears in the cell.

Select the cell that you wish to edit; its contents appear in the edit
area. Type new information if you want to replace the existing
data; or click in the edit area to make changes. Use the left and
right arrow keys on the keyboard to move the cursor as needed.

If you have typed something into the edit area, but don't want the

contents of the edit area stored in the selected cell, click the X
button to cancel the entry. (Alternatively, press 38 +.
(38 +period) on the Macintosh, or Esc in Windows.)

If you have already pressed Tag, clicked V, or otherwise accepted

the entry, then you cannot use the X button. But you can still use
Undo from the Edit menu to reverse your entry, as long as you
choose Undo before making another change to your database.
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Data Entry

Questionnaire
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The following keyboard shortcuts are handy for moving from one
cell to another, especially during data entry:

¢ Press one of the arrow keys (11, =, <, |) to move right or left
to the next cell, or up or down to the next cell.

® Press TAB to move right to the next cell, or, if you are at the end
of a row, to the first cell on the next row. 38+T1AB (Macintosh
only) does the same and creates a record when necessary.

® Press SHIFT+TAB to move left to the next cell, or, if you are at the
beginning of a row, to the last cell on the previous row.

® Press RETURN (ENTER in Windows) to move down to the next
cell. 88+RETURN (CTRL+ENTER in Windows) does the same and
creates a record when necessary.

The questionnaire is an alternative format for adding records to
your database. [t accepts data for one record at a time, as though
filling in a form.

Choose Questionnaire from the Database menu. A dialog appears
with the names of all the fields in the database, along with boxes in
which to enter data. When you choose Questionnaire from the
Database menu, a window appears, as in this example of a
recreation survey:

Questionnaire

Name: abc v |Buris

Gender: abc ¥ |M

Age: # 13

Fav. Sport: abc w |SIJ[:CBI’

Fau. Subject: ab: ¥ |

|
|
|
Fav. Game: abc ¥ |Munupoly |
|
|
|

Play Chess?: % v |

[ < Hatk ] [ Maore >>» ]

For each field in your database (except for formula fields), the
questionnaire window displays:

field name The name as you entered it when you created the
field (i.e., "Name,” “Fav. Game," etc.).

field data type  One of the three types: abc for string fields, # for
number fields, T/F for Boolean (true/false) fields.




The Edit Menu

value menu

text box

This shortcut feature for string and Boolean fields
saves typing the same entry over. Click and hold the

black triangle ™ to choose from a menu of values
previously entered for this particular field.

The area into which you type a value, or where the
value appears that you select from the value menu.

If you don't use the value menu, type a new value in
the text box.

You can enter data in each field, or skip any field and leave the box
blank. Move the cursor from field to field by pressing TAB, or by

clicking the mouse. If all the database fields do not fit on one page,
buttons labeled More and Back appear. Click More to move to the
next page of the questionnaire. Click Back to move to the previous

page.

Once you've completed data entry for this record, click:

Enter

Done

Cancel

To add the new record to your database and keep
the questionnaire dialog open.

To add the new record to your database and close
the questionnaire.

To close the questionnaire without adding data
displayed when you cancel.

Use the Edit menu to duplicate, delete, or reposition a record,
field, cell, or icon. First, select the item that you want to edit.

record, or
record’s icon

records
field

cell

Click the icon at the beginning of a row.

(See Selecting Multiple Records, p. 25.)
Click the field name at the top of the column.

Click the box formed by the intersection of a row
and a column.
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Size and Memory Limits
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Then pull down the Edit menu and make a choice:

Cut Removes the selected item from your database, and
stores it temporarily on the Clipboard so you can
paste it elsewhere.

Copy Makes a duplicate of the selected item, without
removing the original from the database window,
and stores is temporarily on the Clipboard so you
can paste it elsewhere.

Copy Icon Makes a duplicate of the icon in the record you
have selected, and stores it temporarily on the
Clipboard so you can paste it elsewhere.

DPaste Record(s)/ Inserts a cut or copied item. When you paste:
Field/Cell/Icon ® a record, it appears at the bottom of your
database

® afield, it appears at the right of your database
® acell, it appears in the cell that you highlight

® anicon, it is installed as the default icon, if you
have selected the default icon; or as the custom
icon for the records you have selected.

Clear Erases a record, field, or value from the database.

Undo Cancels the last Cut, Paste, Clear, or other
modification to your database.

NOTE: Clear deletes an item from the database window. If you use
Clear by mistake, immediately choose Undo to restore the item
before making any other change to your database.

The limit on the size of a database depends mostly on the speed of
your computer. On most computers, Tabletop will perform well
with databases of 200 records or less. On faster computers, you can
use Tabletop to analyze databases of 500 records or even more.
Tabletop works best with databases that have 50 fields or fewer.

The limit on how many databases you can work with
simultaneously depends on the size of the databases, the number of
tabletop windows that are open, and the amount of memory
allocated to your program (on Windows, the number of custom
icons is also a factor). As the number of large databases and




tabletop windows becomes too high, you may notice a slowing of
the software's performance. Eventually the program will warn you

that memory is running out. Close unnecessary windows and save
your data.

If you would like to work with many large databases at once, you
can increase the memory allocation for the Tabletop program. On
the Macintosh, use the Finder's “Get Info” command to change
Tabletop's preferred size. On Windows, you can free more memory
for Tabletop by running fewer programs at the same time,
increasing virtual memory, or installing more memory in your
computer. See the documentation that comes with your computer
system for more information on memory for running programs.

Windows computers have an additional limitation on “graphics
memory” (GDI). Graphics memory can run low when there are
more than 120 custom icons in the databases that are open, or
when you run many other graphics-intensive programs at the same
time as Tabletop.
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Overview

Annotations
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Besides setting up the basic structure of your database and entering
the data, Tabletop also allows you to customize your database
using these features:

¢ Annotations to add notes about your data
¢ Sorting to reorder the records in the database window
¢ Icon Editor to design or choose the icons that stand for records

¢ Fat Rows to make room for larger icons to be seen in full size in
the database window

In the database window, use the Annotation features to write
additional information about the data you have collected. For
example, you might want to explain what the data describe, to cite
information sources, or to clarify assumptions and measurement
methods.

These notes can be entered in two forms of annotation. The
database annotation is a single body of text relating to the entire
database. Field annotations are separate bodies of text for each field.

Both annotations can be viewed and edited in the annotation area, a
section of the database window that can appear above the field
headings. Open and close the annotation area using the annotation

the annotation area is open, you can change its size by dragging
the split bar on the right of the window.

recreation survey

This database contains survey data collected by Javier, Paul and Rachel.‘
wanted to find out what people of different ages like to do for fun. Also we
wondered if people’s favorite subject has anything to do with what they do for
fun.

¥We asked everyone in Ms. Klemp's class these questions. Also we asked
people in our familiesl




Database Annolation.

Choose Database Annotation from the Database menu.
(Alternatively, use the annotation button % to open the
annotation area, and click the default icon once to see the
database annotation.) The annotation area appears, along with
any database annotation text that has been stored.

— To add text to the database annotation, click in the
annotation area and type the notes you want associated
with this database. You can also edit text that was entered
previously.

— To close the annotation area, click the annotation
button 2. An asterisk (*) appears inside the annotation

button to indicate that the annotation area contains notes
regarding the database.

Field Annotation.
— Select the field by clicking the field heading.

— If the annotation area is not already open, click the
annotation button .

— To enter an annotation, click the cursor in the annotation
area and type the notes you want associated with this field.
You can also edit text that was entered previously.

— To close the annotation area, click the annotation
button 2. An asterisk (*) appears inside the annotation
button to indicate that the annotation area contains notes
regarding this field.

When you print the database, database and field annotations
appear as endnotes.
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Sorting a Database

© 1995 TERC. All rights reserved.

You can sort the records in your database using any data in the
database as criteria. Choose Sort from the Database menu. The
Sort dialog box appears.

Sort by

1st key: [¥ Age lis.

2nd key: [* Play Chess? Ll

3rd key: [¥ None il

The Sort dialog allows you to sort based on one, two, or three sort
keys. For each key, specify a field and choose either ascending or
descending order. Click and hold the black triangle, and choose a
field from the menu that pops up. Click the symbol to the right of
the field name to choose between ascending sl or descending Il
order. (In Windows, click the radio button next to the appropriate
symbol.)

The second and third sort keys are optional. If you simply want to
sort by one field (for example, sorting the cats by their age),
specify a first sort key and leave the other two keys as None. If
you specify a second sort key, it is used to order sequences of items
that are equal in the first sort key. For example, a phone book uses
last name as a first sort key and first name as a second sort key. If
you specify a third sort key, it is used to order sequences of items
that are equal on both the first and second keys.

Click:

Sort To order the records as you have specified.
Cancel To leave the dialog without sorting the database.
Unsort To return the records to the pre-sort order.

Tabletop sorts data only when you tell it to. If you add or change
records after sorting your database, the ordering is not maintained
automatically. Use the Sort dialog to re-sort your data at anytime.




lcon Editor

The icons that appear at the left of records in the database window
stand for those records in plots and graphs in the tabletop window.

Using the Icon Editor, design or choose icons to make your graphs

easier to understand, more appealing, or more informative. You can
edit two kinds of icons:

Edit the default icon if you want to determine how all, or most,
of the records in your database will appear. For example, in a
database of cats you might make all the records look like cats;
in a database of books you might make all the records look
like books. The default icon appears in the upper left of the
database window, at the beginning of the row of field names.
It is used for any record that does not have a custom icon.

Make a custom icon for a record if you want the record to look
different from other records in the database. You might give a
special coloring to two calico cats, make Tolstoy's War and Peace
look fatter than all the other books, or create a different flag
icon for each record in a database of countries. Records that do
not have a custom icon use the default icon.

(Note: In Windows, a maximum of 75 custom icons for each

database is recommended, because of graphics memory limitations.)
To edit either the default or custom icon, click the icon then
choose Edit Icon from the Edit menu. (Alternatively, open the Icon
Editor by double-clicking an icon.)

Custom lcon - cats with fur

Al=>e]c]
Y o]=]e]s]

Copy ] [ Paste ]
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The Icon Editor displays the selected icon and indicates in the

upper left corner whether it is a custom icon or the default icon.
You can draw a new icon by first selecting a color in the palette
and then clicking in the draw area. "“Draw” or edit the icon one
square (or pixel) at a time. You can also edit an icon by using these

buttons:

Clear Erases the draw area so that only the gray default
background color appears.

Default Replaces the icon in the draw area with a copy of
the default icon.

Copy Moves the icon in the draw area to the Clipboard.
You can also copy an icon to the Clipboard without
opening the Icon Editor use Copy Icon from the
Edit menu.

Paste Puts a copied icon from the Clipboard into the
draw area. The icon on the Clipboard can come
from another record, another Tabletop database, or
even another graphics application.

Revert Replaces the contents of the draw area with the
icon displayed at the time you opened the Icon
Editor.

Get Places an icon selected from the library into the
draw area.

OK Replaces the icon you selected before opening the
Icon Editor with the contents of the draw area.

Cancel Closes the Icon Editor without making any changes

to the selected icon.

The Icon Library is displayed at the right side of the Icon Editor. It
includes more than 100 pictures of common objects. Browse
through the library by clicking the « and P> arrows. To use an
icon from the library, click the icon, then click Get.

You can give several records in your database the same custom
icon. For example, you might want to use one bird icon for all the
birds in a database of animals. This is most conveniently done by
copying and pasting. First, copy the desired icon, from either the
Icon Editor or a selected record, using Copy Icon from the Edit
menu. Then, in the database window, select the records that you
wish to have the custom icon. (Use SHIFT, 88 , or CTRL to select
multiple rows. See “Selecting Multiple Records,” p. 25.) Once the
rows are selected, choose Paste Icon from the Edit menu.




Fat Rows Fat Rows magnifies the rows in a database to accommodate icons

larger than the text. Choose Fat Rows from the Database menu. To
return the rows to their original size, choose Fat Rows again.
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IMPORTING DATABASES

NANANANANANANANANANAN

Joining Tabletop
Databases
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Sometimes two or more databases of related information can be
used more effectively if they are all part of one database. The Join
Databases command allows you to link the contents of two or
more different databases. A common use of this feature is to
combine data collected by different groups into one large database.
Databases can be combined in two ways:

e Append adds records to the end of a database. The records can
contain the same or different fields, or they can have a
combination of both. For example, two people who have each
created a list of books containing authors, titles, and publishers
can combine their lists into one large database of all the books.

®  Merge adds fields at the right of a database. For example,
suppose that one person has information about the native
language and favorite food of everyone in class, another person
has information about their heights and weights, and a third
person has information about their genders and favorite
musicians. The common factor in all three sets of data is the
names of the people in the class. Because there is a common
factor, these three databases can be merged into one class list
containing all the information fields.

To join databases:

1. Choose Join Databases from the Database menu. The join
window appears. In the following illustration, two databases,
“Literature” and “Books,” have been selected as an example.

&ppenﬁ Mergs l Clear
o Literature l m@
®vtoe b Pogec

¥ Nane |




Exporting Data

2. A black triangle ® appears under the heading “Database
Name."” Click and hold the triangle to see a list of currently
open databases. Select the database you want. To specify a
database that is not already open, select Open Database, near
the bottom of the list.

3. Once you have specified a first database for joining, a new row
opens to let you specify a second database, and so on.
Continue until all the databases that you wish to join are listed.

4. The white tiles that appear to the right of each database name
stand for the fields in that database. Use these to make sure
that the fields from the different databases are lined up the
way you want. Sometimes fields in different databases are
essentially the same, but their names are different (e.g., “Title"
and “Book”). Tabletop does not know automatically that these
fields contain similar information. Drag tiles sideways into the
same column to match up fields that contain corresponding
data. This way, you tell Tabletop that they are the same and
should be combined. Note that different fields can be
combined only if they are of the same data type (number,
string, or Boolean).

5. Click one of the buttons at the top of the dialog box:

Append To join databases bottom to top, record by record.
Merge To join databases side to side, field by field.

Clear To remove the names of the databases you have
selected and start over.

The process does not modify the original databases. Instead,
their information is copied into the new database. Tabletop
automatically provides the default name “Joined Database 1"
for this database. You can assign it a new name when you save
the database.

At times you may wish to use Tabletop data in a different database
or spreadsheet application such as Claris® FileMaker Pro, Claris®
Works, or Microsoft® Excel. You can save your data in a format
that is recognized by these other database applications.

With the database window in front, choose Save As from the File
menu. The Save File dialog includes a button labeled File Format

(Windows: File Type). Click and hold this button to view the

menu and select one of the two format options:
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¢ Tabletop (Windows: *.tdb). This is the default setting. Only

the Tabletop application can read files in this format.

e Text. Select Text if you want to save the file as a generic text
file that can be read by a variety of other applications. When
you select the Text option, the Text File Options dialog box
appears.

| Text File options
| @ Tab

Use a O) Comma between each field

[JFirst line contains Field names

You have the option of saving your database with tabs or commas
separating the text. The one you choose depends on the options
available to you in the database to which you are transferring the
data. Fundamentally, they are both the same. If you would like
field names to be included in the file, click in the box next to “First
line contains Field names.” Click OK when you are finished, or
click Cancel to close the dialog box and cancel the saving process.

Using Commas as Separafors When you use commas as separators, you may notice that commas
previously entered in your database have been removed. For
example, a database entry of “Black, brown, gray” is changed to
“Black brown gray"”. This happens because commas in data are not
compatible with commas as separators. Tabletop removes the
commas from your data automatically to produce a text file that
can be read unambiguously.

Supplemenfary Information The Tabletop's file format includes annotations, column widths,

ls Not Exported field formats, icons, and other supplementary information about
how you have chosen to view your data. When you export a
database, this supplementary information is not passed on.

© 1995 TERC. All rights reserved.




Importing Data

Tabletop can read data in a text format.

Choose Open from the File menu. The Open File dialog includes a
button labeled File Format (Windows: List Files of Type). Click and
hold this button, and select the format of the file you want to
import. If it is a text file, select Text. If you are unsure of the
format, select All Files. Proceed with your computer system'’s
standard procedure for opening the file.

If the file is in text format, the Text Options dialog appears next.

Text File Dptions

(& Tah

Use a ) Comma between each field

[JFirst line contains Field names

Specify whether fields in the text file are separated by tabs or
commas and whether the first line of the file contains field names
instead of data values.

This process creates a Tabletop database from the imported data.
Check to see if the data types of the fields are set correctly. Some
numeric and Boolean fields may have been interpreted as string
fields. You can correct this easily (see “Define a Field Type,” p. 21).
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PLOTTING DATA 7
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The tabletop window is where you can explore and analyze the
data in your database. Database records are represented by
movable icons that can arrange themselves according to your
specification. Before you create a graphic view of your data,
practice moving around the tabletop window, using the following
two sections.

The tabletop window offers three kinds of plots, called Venn, Stack,
and Axes. Combined with the facilities for labeling and marking
icons (Chapter 8) and for making summary computations (Chapter
9), these plots allow you to organize, visualize, and present your
data in a variety of ways.

The tabletop window also includes features for annotating
(Chapter 9) and saving (Chapter 10) the plots you make. You can
use these features to prepare presentations, to retrace the steps of
your thinking, or to repeat similar analyses with different sets of
data.

Open Tablefop Window Every tabletop window is associated with a particular database. To
open a new tabletop window, start from an open database window,
and choose New Tabletop from the File menu. The tabletop button
£ in the upper right corner of the database window also opens a

{Houses] Tabletop 3

Street No.:
Stories:
Roof Color:
Porch?:
Garage?:
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Return to the
Database Window

The Venn Loop Plot

new tabletop window the first time you click it. Once a tabletop

window is open, use this button to switch easily from the database
window to the tabletop window (the tabletop window has a
corresponding button for switching to the database window).

When the tabletop window first appears, the icons (which
represent records) are randomly arranged. Click and drag an icon
to reposition it, or double-click an icon to see the data contained in
its fields.

To return to the database window, click the database button & in
the lower right corner of the tabletop window. The corresponding
database window comes to the front. To make one of these plots,
begin by pressing the appropriate button in the lower left of the
tabletop window:

o @’j the Venn loop button
. _"IE"J the Stack button
. _L;i the Axes button

When you open a new tabletop window, it automatically opens
(defaults) to a Venn loop plot.

The Venn loop plot, like a Venn diagram, is used to separate
objects into groups, based on their characteristics. For example, in
a database containing all the houses on one street, the houses with
porches might be in one loop, and the houses with red roofs might
be in a second loop. Because some houses might have both porches
and red roofs, those houses would be in the area that is formed by
the intersection of the two loops. If a third loop contains the
houses with more than two stories, the intersection of the three
loops would contain only those houses that have porches, red
roofs, and more than two stories. The plot would have separate
regions for every possible combination of having or not having a
porch, a red roof, and more than two stories, including an outer
area for houses that have none of these.
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ﬁ Roof Color
Sinries > 2
B

Here's how to create a Venn loop.

Step 1: Click the add loop button #!in the lower left corner of
the tabletop window.

An "undefined” loop appears:

The three squares 7 % 2 that appear in the upper left corner of
a loop are the loop constraint boxes. The first box is the field, the
second box is the comparison, and the third box is the value.
When all three are defined, the boxes look something like this:
root tolar! < ired| Use these boxes to define which records (icons)
you want to be included in a loop. This Venn loop would
contain all the houses for which “red” was in the “Roof Color”

field.

from the menu that pops up. (You can also choose Formula. A
formula editing dialog appears, in which you can type a
constraint formula. The other two loop constraint boxes
disappear. See Chapter 12 for more information on the formula
language.)
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Step 3: Select an operator with the second 2|. These are your
choices:

If the type of field is:

The options you see are:

Which means:

string

number

Boolean

is equal to...
is not equal to...

contains the sequence of
characters...

is less than...

is less than or equal to...

is equal to...

is not equal to...

is greater than or equal to...
is greater than...

is equal to...
is not equal to...

If the type of field is:

The options look
something like this:

Which means:

string

number

Boolean

black
brown
green
red

Typical values for the
selected field are listed in
the menu. Choose one, or
choose Other to type in
something different.

Type a number that you want
the data compared to. Click
or press Return or Enter to
accept the number; click X to
cancel your entry. The range
of actual data in the selected
field is displayed for your
reference.

Choose either true or false as
the comparison value.
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The Stack Plot

© 1995 TERC. All rights reserved.

Once you have made valid entries for all the loop constraint boxes
(or entered a valid formula), the icons in the tabletop window
rearrange so that only those meeting the criteria are inside the
Venn loop. You can change any of the loop constraint boxes at any
time. The icons move to reflect the changes you make.

To create another loop, click the add loop button ¥l again. Follow
the same steps as outlined above. You can have up to three Venn
loops in the tabletop window at one time. The icons rearrange
each time new rules (or new Venn loops) are introduced.

To close a Venn loop, click in the small square attached outside the
Venn loop.

The Stack plot is Tabletop's equivalent of a histogram. It helps you
look at the distribution of values within one field of the database.
Icons are stacked according to categories or numerical ranges. The
height of each stack depends on the number of records in each
category or range. The more records, the higher the stack.

Click the stack button i in the lower left corner of the window.
Initially, the icons arrange themselves in one big stack. To make a
more interesting plot, assign a field to the X-axis. Click and hold
the X-axis selector. A pop-up menu appears, containing field names
and other options. If you choose:

®  Field Name. Tabletop plots the icons according to data entered in
that field.

o Formula. Tabletop plots the icons according to the formula you
enter. (See Chapter 11, "Using Formulas.")

e  No Constraint. Tabletop restores the axis to its original neutral
X-axis form.




Editing the Axis of a
Stack Plot

Once you select from the choices above, the axis is automatically
labeled, and icons rearrange into stacks. The numbers running up
the left side of the plot help you count the icons in each stack.

T b (2=

The stacks of a Stack plot can be based either on ranges (as in this
example) or categories; for example: Male and Female; or North,
South, East, and West. By default, numbers are grouped into
ranges, and strings are treated as categories.

When you choose a field for the axis of the Stack plot, Tabletop
automatically figures out how to label the axis, based on the actual
data in your database. Sometimes you may want to customize or
edit features of the axis, such as the order of categories, the size of
numeric intervals, the extreme values, etc.

Tabletop provides two levels of support for this. The following
changes can be made by clicking the parts of the axis directly:

®  You can change the limit of a range axis. For example, in the
preceding figure you might click the boxed number 24| and
change the upper limit of the axis to a higher or lower number.
(To change the other end of the axis, open the Axis Edit bar).

e When an axis is labeled with categories instead of ranges, you
can change the order of categories (such as roof colors) by
dragging the category names left or right. As you drag, a small
diamond shape shows where the category will be inserted when
you let go.

Tabletop User's Manual



The Axes Plot
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¢ You can add categories into a column labeled Other by
dragging them to the right. The diamond shape turns to a circle
to indicate that you have reached Other.

® You can separate categories from the Other column by clicking
and holding the word Other, and selecting from the menu that

pops up.

More extensive changes are possible by opening the Axis Edit bar.
See Chapter 9.

When you edit an axis, Tabletop remembers the changes you made
and uses them the next time you make a Stack plot with that field.

The Axes plot is in some ways the most flexible of the three plots.
It allows you to compare multiple values from one field against
multiple values in another field. Scatter plots and box plots (shown
below) are just two of the many kinds of data representations you
can make with different axes plot options.

The axes plot has both an X-axis (horizontal) and a Y-axis
(vertical). You can control these using the X-axis button and the
Y-axis button (see figure below). The label on an axis button says
what data are being plotted on that axis.

Depending on the kind of data you assign to each axis, the plot
may look like a scatter plot...

= |lelements] Tabletop 1 2




or a grid chart...

[Cats] Tabletop 1

Bye color

yellow

e
black pink and black

pad colnrl

bottom left of the window. The axis buttons appear. Initially, when
both axes are in a null state, the buttons are labeled simply

X Axis and Y Axis.

Click and hold the X-axis button. From the menu that pops up,
choose one of the following:

¢ Any field from your database. The axis is labeled according to
the chosen field, and icons move to line up with the X-axis
based on their data values for the chosen field.

e Formula. A window appears in which you can enter a formula for
the axis. See Chapters 11 and 12 for information on using
formulas.

e No Constraint. The axis returns to a null state.

Next, click and hold the Y-axis button. The choices available here
are the same as those for the X-axis.

You can change your selections for the X- and Y-axes at anytime.
Simply click and hold the axis button, and the same menu of
choices is available again. Every time you change an axis, the icons
rearrange themselves accordingly.
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Editing Axes in an Axes Plot
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When you choose a field for an axis in the Axes plot, Tabletop
automatically figures out how to label the axis, based on the actual

data in your database. By default, numerical data are plotted
continuously, and the highest and lowest data values are used as
axis limits. String data and Boolean data are plotted as categories,
with the categories ordered from the most to the least frequent.
Sometimes you may want to customize or edit features of the axis,
such as the extreme values, the order of categories, the size of
numeric intervals, etc.

Tabletop provides two levels of support for this. The following
changes can be made by clicking the parts of the axis directly:

®  You can change the limits of a continuous numerical axis.
Simply click the boxed number at either end of the axis; in the
small window that pops up, enter a new limit value. For
example, in the figure on page 47, the lower end of the Y-axis
has been set manually to -273 (“absolute zero"), even though
no actual melting points are that low.

¢ When an axis is labeled with categories (such as roof colors),
you can change the order of categories by dragging the
category names along the axis. As you drag, a small diamond
shape shows where the category will be inserted when you
let go.

¢ You can add categories into a column labeled Other by
dragging them to the right side of the X-axis, or to the top of
the Y-axis. The diamond shape turns to a circle to indicate that
you have reached Other.

®  You can separate categories from the Other column by clicking
and holding the word Other, and selecting from the menu that
pops up.

More extensive changes are possible by opening up the Axis Edit
bar. See Chapter 9.

When you edit an axis, Tabletop remembers the changes you made
and uses them again the next time you make an Axes plot with that

field.




Box Plots

Mo Data

nanmetailic semimetallic

metallic? i

You create a box plot by overlaying visual statistical information on
an Axes plot. The box plot shows the median, the range, and the
quartiles of a set of numbers. A “box” encloses the interquartile
range (the range in which the middle half of the data points fall); a
line through the box indicates the median; and “whiskers” extend
to the extreme values.

€
Upper extreme of data

Upper quartile (1/4 of icons in this group
are above this point; 3/4 are below it)

Median (1/2 of icons are above
this point, 1/2 below)

Lower quartile (3/4 of icons are
above this line, 1/4 below)

|« Lower extreme of data
To show a box plot:

1. Make an Axes plot.
2. Choose Box Plot from the Tabletop menu.

Tabletop User's Manual



NOTE: For a box plot to appear, either the X- or the Y-axis (or
both) must be continuous. If the other axis divides the icons into
groups, a separate box-and-whisker overlay is drawn for each
group. If both axes are continuous, the boxes for X and Y are
combined into one box which can be read both vertically and
horizontally.

Box Plot Options In some cases, statisticians prefer to use an alternative method for
drawing box plot whiskers. Rather than extending to the extremes
of the data, the whiskers have a length that is proportional to —
usually one and one half times — the interquartile range.
(Interquartile range, or IQR is the difference between the upper
and lower quartiles). To use this method, select Box Plot Options
from the Tabletop menu. A dialog box appears:

Where do you want the box plot whiskers
placed?

{® Extremes of Data

Y

“Extremes of Data" is the default selection. To use the IQR method,
click the second option. You can change the multiplier from 1.5 to
another value if you wish. Click OK when you have made a
selection.

© 1995 TERC. All rights reserved.
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ICONS
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Selecting lcons

Selecting lcons Directly

Selecting All lcons in a
Region

© 1995 TERC. All rights reserved.

To take full advantage of the Marking, Labeling, and View
Constraint features discussed in this chapter, you need to know the
different ways that you can select icons in the tabletop window.
Selecting is how you tell Tabletop which icons should be marked,
labeled, etc.

To select one icon, simply click the icon.

To select several icons, click one of them. Then hold down the
SHIFT key while clicking each remaining icon in turn.

Selecting a region in 2 Loop plot

Suppose you want to select all the male cats (perhaps because you
want to mark all the icons). There is an easier way than clicking
the cats one by one. Make a loop that contains just the male cats,
then click the surface of the Tabletop inside the loop.

..
&

&
&
S [~ o Jomme]w Seereton < Fien

The area inside the loop highlights, and a notation appears in the
upper right of the window, describing your selection. All male cats

%@%

are now selected (see figure above).
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You can select multiple regions in a Loops plot by holding down
SHIFT as you click in each region

Selecting a region in a Stack plot

You can select one or more regions in a Stack plot as well. Simply
click the tabletop background, above the section of the axis you
wish to select. To select multiple regions, hold down SHIFT as you
click in each region.

Selecting a region in an Axes plot

When axes are not continuous, click in any “cell” of the plot to
select it. In an Axes plot with a continuous axis, click and drag to
delimit a rectangular region within the plot (see figure below).

Release the mouse button, and the region is selected.

Running along the inside of each axis is an invisible area called the
“gutter.” Click and drag inside the gutter to select an entire band
across the plot (see figure below).
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Marking lcons
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[Cats] Tabletop 1 &

B H

To select multiple regions in an Axes plot, hold down SHIFT as you
select each region.

Field biologists often put tags on or “mark” animals that they are
studying. Marking the animals allows them to observe the animals’
migrations and other living patterns, which helps the biologists
learn more from the data they collect. In Tabletop, you can mark
records (in the form of icons) so that you can watch their
movements as you change rules in the various plots.

To mark a single icon:
1. Click the icon.

2. Select Marking from the Tabletop menu. The following dialog
box appears.

Mark Selected lcons with:
[]Box ) _

[ Color: . §§.§

3. Check Box if you want to put a black frame around the icon.

4. Check Color and select one of the colored squares, if you want
to mark the icon with color. (If your monitor is black and
white, gray is the only “color” you can select.)

5. Click OK to proceed with marking the icon, or click Cancel if
you don't want to mark the icon.




Labeling lcons

You can mark the icon with a box, a color, or both a box and color.

To mark multiple icons, select the icons (see “Selecting Icons,”
page 53), then choose Marking from the Tabletop menu. Make
your choices in the dialog box. All the selected icons will be
marked.

To unmark (remove the marking from) specific icons:
1. Select the icon(s) that you want to unmark.

2. Choose Marking from the Tabletop menu. A dialog box
appears.

3. Click in the square next to Box and/or Color to remove the X.
Click OK. The marking is removed from the icons.

To remove all markings from all icons, choose Unmark All from
the Tabletop menu.

Icons can be labeled with data from any field in the database.
Labels can be used to add an extra dimension of information to a
plot or to identify individuals.

To label one or more specific icons:
1. Select the icons or a region of the tabletop.
2. Choose Label Selected Icons from the Tabletop menu.

3. Click and hold the black triangle ¥ in the Label selector

tebetjwnans | at the bottom of the tabletop window. Select
the field you want as the icon label.

To label all icons:

1. Click and hold the black triangle ® in the Label Selector

OI‘:
2. Click the L8Bel] button.

To remove labels from all icons, click the L2l button.
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Half-Size lcons

View Constraint

Opening a New Tabletop for a
Selected Subgroup

Specifying a Formula for the
View Constraint
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Labels can sometimes overlap and look messy. One way to clean up
this appearance is to label some of the icons rather than all of
them. Another way is to make a field with abbreviated data. For
example, in a database of countries, have a field called Short Name,
with names like Ger and Ind rather than Germany and India, just
for labeling icons.

When there are many icons on the tabletop, some plots will look
crowded. Reducing the icons can make the plot easier to read. To
reduce the size of the icons displayed in the tabletop window,
choose Half-Size Icons from the Tabletop menu. When you want
to return all icons to their original size, choose Half-Size Icons
again.

At times you may want to focus on a subset of the records in your
database. The View Constraint feature lets you define rules to
create and display a subset of database information in a tabletop
window.

The simplest way to create a View Constraint is by selecting a
region of a plot, then choosing New Tabletop from the File menu.

For example, suppose you want to focus on the older male cats for
a while. Make a Venn plot with a loop for older cats and a loop for
male cats. Click in the intersection of the loops, then choose New
Tabletop. A new tabletop window appears, containing only the
icons from the selected region. A notation in the upper left of the
tabletop window describes the view constraint that is currently in
effect.

You can open a new tabletop with a view constraint on any
selected group of icons. See "Selecting Icons," page 53, for all the
ways that you can select icons.

You can also set the view constraint for the current tabletop
window (rather than a new one), by entering a formula. Choose
View Constraint from the Tabletop menu and type in the formula.
Icons for which the formula returns true remain in view; icons for
which the formula returns false are excluded. To reinstate all icons
in the current window, choose View Constraint and click View All.
For more information on view constraint formulas, see Chapter 11.
For more information on the formula language, see Chapter 12.
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OTHER TABLETOP WINDOW FEATURES 9

Annotating Plots

Computations
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Like the database window, the tabletop window has an annotation
area, where you can type notes about a particular plot. Open the
annotation area by choosing Show Annotation from the Tabletop

corner of the tabletop window. Choose Hide Annotation from the
Tabletop menu or click the annotation button again to close the
text area.

Tabletop has the ability to compute basic statistical information
about groups of data in your database. Use a Tabletop plot to
group your data: computations, such as counts, averages or totals,
can then be applied to each group.

ICats] Tabletop 1

Median weight of cats, by sex and age.




elements] Tabletop 1

monmetallic sermimetallic

meiallic? |

Tabulation of chemical elements, by group and metallic properties.

To make a computation:

1. Make a plot that groups your records in the way you want.

2. Click and hold the black triangle in the operation button
¥ dperation] at the bottom of the tabletop window. From the
menu that pops up, choose one of the following operations:

Count
% of Tolal

Total
Mean
Median
Smallest

Largest

Displays the number of icons in each group.

Is similar to Count, but the number of icons in each
group is expressed as a percentage of the total
number of icons on the tabletop.

For each group, displays the sum of all the values in
a Number field that you select.

For each group, displays the mean (average) of all
the values in a Number field that you select.

For each group, displays the median (midpoint) of
all the values in a Number field that you select.

For each group, displays the smallest value in a
Number field that you select.

For each group, displays the largest value in a
Number field that you select.
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Customizing Stack and
Axes Plots

The Axis Edit Bar

© 1995 TERC. All rights reserved.

Percent For each group, displays the percentage of True (or
Yes) occurrences in a Boolean field that you select.

3. For all operations except Count and % of Total, specify a Data
field to be used in the computation. Click and hold the black
triangle # in the field button * g% | From the menu that
pops up, select a field. Only fields compatible with the chosen
operation can be selected.

Tabletop hides the icons and shows the results of the computation

seeing icons and seeing computation results.

If you try to show computations when the operation and field are
incompatible (e.g., asking for “Smallest” in a Boolean field), or not
completely specified, Tabletop displays question marks.

In computing averages, medians, and percentages, records with no
data for the selected field are ignored.

Stack plots and Axes plots graph data against one or two axes.
When you specify a field or formula to be plotted on an axis,
Tabletop takes care of many details automatically: what values to
mark and label on the axis, what order to put categories in, how
many labels to put on the axis, etc.

To get your graph just the way you want it, you can take control of
many details of an axis, including the extreme values at either end,
the size of range intervals, the order of categories, and more.
Tabletop remembers the changes you make and applies them
whenever you use the same data field in the same kind of plot.

You can make some changes to an axis by clicking the axis directly.
More extensive changes are possible using the Axis Edit bar, a
special control area that can appear in the tabletop window, just
below the plot area. When the plot has an X- and a Y-axis, the Axis
Edit bar has separate sets of controls for each. To open the Axis
Edit bar, choose Show Axis Edit Bar in the Tabletop menu. After
editing, you can hide the Axis Edit bar by choosing Hide Axis Edit
Bar from the Tabletop menu.




Editing a Continuous Axis

Axes in Tabletop plots fall into three axis types:

Continuous s like a segment of the number line. Every icon
lines up with an exact point on the axis, based on its
data.

Range Separates numerical data into groups based on
boundary values.

Categorical Separates data into groups based on individual data
values (e.g., roof colors).

The edit bar includes an axis type selector. You can use the selector
to change an axis from one type to another, subject to these
constraints:

¢ Continuous and range axes apply only to numerical data.
e (ategorical axes are allowed with any kind of data.

¢ Continuous axes can be used in Axes plots but not in Stack
plots.

Continuous, range, and categorical axes can each be edited in
different ways.

Editing a Continuous Axis directly

You can change the upper and lower limits of a continuous axis.
Simply click the boxed number at either end of the axis; a small
window pops up to accept your entry.

To specify a new axis limit, type the new limit value and click V (or
press RETURN or ENTER).

To let Tabletop determine the axis limit flexibly, based on the
actual limits of the data, click Reset.
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Editing a Range Axis
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v Duﬁtinuaus{ Resetf » Cnntinuous§ Rese §

When the Axis Edit bar is open, you can:
e (Click Reset to reset both axis limits.

¢ (Change the axis type to range or categorical.

You cannot control the placement of tick marks on an axis. These
are always determined automatically by the program.

Editing a Range Axis directly

When the stack plot is divided into ranges, the number at one end

of the axis has a box around it #2|. This is the "hard end"” of the axis
(the “soft end” is discussed below). To change this limit, click the
boxed number. A small window pops up to accept your entry.

To specify a new axis limit, type the new limit value and click V (or
press RETURN or ENTER).

To let Tabletop determine the axis limit flexibly, based on the
actual limits of the data, click Reset.

Editing a Range Axis with the Axis Edit bar

Note that when the Axis Edit bar is open, additional range axis

controls also appear in the plot area.

Sireetl na |




Editing a Categorical Axis

e The Min or Max button. Depending on your inclusion setting
(see below), a button labeled Min or Max appears present.
Click this button to enter a new value for the “soft end” of the
axis. This is called the soft end because you can only specify an
approximate axis limit: Tabletop sets the exact limit by
counting from the other end (the "hard end") in regular steps.
Tabletop makes sure that the number you enter as Max or Min
is included in the last range on the axis.

e The Step button. Click this button to specify the step or
interval that each range spans. If the interval is too small,
Tabletop may override the interval you specify, to
accommodate the axis limit values and keep all labels legible.

On the Axis Edit bar itself, you can:

e Click 7 or 7! to control inclusion of boundary values. For
example, a set of ranges might be 100-200, 200-300, 300-400,
etc. Does 200 belong to the first group or the second group?

¢ C(Click Reset to set inclusion to % and to let Tabletop determine
maximum, minimum, and step values based on the data.

e Use the axis type selector to change the axis type to
continuous (in Axes plots only) or categorical.

Editing a Categorical Axis Directly

Tabletop automatically orders categories from the most to the least
common. To change this order, simply click and drag a category
label to a new position on the axis. As you drag, a diamond (@)
shape shows where the category will be inserted.

When there are more values than will fit in the window, Tabletop
creates an axis label called Other, at the right of the X-axis, or at
the top of the Y-axis, including all the less frequent categories. To
remove a category from Other, click and hold Other and select the
category from the menu that pops up. The chosen category
appears on the axis, and the icons rearrange accordingly. Because
there is a limit to the number of categories that can be seen at one
time, another category may be absorbed into Other instead.
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Print a Tabletop Window

Window Snapshot
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You can also reduce the number of categories displayed by

dragging a category into Other. Drag the category label to the
right of the X-axis, or to the top of the Y-axis, until you see a circle
::

created, if none existed before, and the category is absorbed into it.

) shape; then release the mouse button. An Other label is

Editing a Categorical Axis with the Axis Edit bar

When the Axis Edit bar is open, you can:

e

qreen

Roof Ceinr!

¢ C(Click Reset to let Tabletop determine the category order and
the contents of Other flexibly, based on the data.

¢ Change the axis type (provided the data is numerical) to
continuous (Axes plots only) or to range.

To print your tabletop window, select Print from the File menu
when the window is in front. The printout includes your plot and
annotations, but omits other parts of the window such as the Plot
Recorder.

The size of the printout depends on the size of the window at the
time you print. Larger windows often fit better on the page if
printed in landscape mode. To use landscape mode, choose Page
Setup from the File menu (Windows: Print Setup), and follow your
computer’s standard procedure for setting the page orientation.

This feature is useful for including plots and graphs in reports and
other documents. To take a “snapshot” of your tabletop window,
choose Copy from the Edit menu when the window is in front. A
picture of the plot is stored on the Clipboard. You can paste this
picture into another application, such as a word processor or a
paint program.
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SAVING AND REUSING PLOTS 10
NANANANANANANANANA N

The Plot Recorder The Plot Recorder saves individual plots so that you can retrieve
them later. The saved information includes icon labels and
markings, view constraints, annotations, as well as axis or loop
definitions. Choose Show Plot Recorder from the Tabletop menu.
A vertical bar appears on the right of the tabletop window, as in
this example:

[Motion.db] Tabletop 1

.
=
E
=
i
a
=t
i

—_—
crawling walking back... hopping

w Continuous: Reset

@ 1. Lebel |¥ Name of .

The Plot Recorder has two sections:

® The History Bar. The upper portion of the bar contains a button
for each plot that you have created. Tabletop stores these

automatically, putting the most recently created plot at the top
of the History bar.

o The Slides Bar. The lower portion of the bar is where you can
store selected plots for later use.

NOTE: The history is limited to the last 30 plots you made. Older
plots are deleted as new plots are added. To save a plot
permanently, store it in the Slides bar.

Store plots in the Slides bar, using either of these two options:

¢ C(lick the Slides button to store the currently displayed
plot.
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Saving Your Tabletop
Window

Saving a Tabletop Window

¢ Choose a previously created plot by clicking a plot in the
History bar. The selected plot appears in the tabletop window.
Then click the Slides button to store that plot in the Slides bar.

You also have these options when using the Plot Recorder:

® Retrieve a plot. To retrieve a plot stored in either the History bar
or the Slides bar, click the button of the plot you want to open.
The plot appears in the tabletop window.

®  (Clear History. To delete all stored buttons in the History bar,
choose Clear History from the Tabletop menu.

®  (lear Slides. To delete all the stored buttons in the Slides bar,
choose Clear Slides from the Tabletop menu.

Tabletop automatically retains the most recently displayed Venn
loop, Stack plot, and Axis plot, so that even after you Clear
History or Clear Slides, you can still display these plots by clicking
the plot buttons

You can save your tabletop window in a file. The saved
information includes the current plot and the contents of the
History and Slides bars. This feature is useful for preparing a
presentation, saving your work so that you can resume it later, or
sharing your graphs with others.

NOTE: When you save a tabletop window you are only saving the
specifications for the plots; the contents of the database are not
saved in the tabletop file. To recreate your graphs you need both
the associated tabletop file and database file (see "Opening a
Tabletop File," page 69).

To save your tabletop window:
1. Bring the tabletop window to the front.
2. Choose Save from the File menu.

3. Follow your computer system's standard procedure for saving
a file.
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Opening a Tabletop File

Install New Database
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To open a tabletop file (i.e., a file in which you saved a tabletop
window):

1. Choose Open from the File menu.

2. Follow your computer system's standard procedure for opening
a saved file.

If the database for this tabletop window is already open, the saved
tabletop window opens immediately. If the database is not already
open, Tabletop opens it first, then opens the tabletop window.

If the database file has been moved from its previous location,
Tabletop cannot open it automatically. Instead, a dialog appears,
asking if you can find the database file. Click Yes: A standard file
dialog appears, allowing you to locate the database. Alternatively,
click No: Tabletop creates a blank database template, with fields
defined appropriately for the plots in the tabletop window.

At some point, you might want to use the plots in your tabletop
window to analyze a different database. For example, suppose two
groups collect similar data on acid rain. Group #1 analyzes its data
in the tabletop window, and builds a slide show containing a series
of useful graphs. Then Group #1 wants to look at Group #2's data,
using the same graphs. Group #1 would install Group #2's database
into its current tabletop window.

Choose Install New Database from the Tabletop menu. The
following dialog box appears.

Choose a new database to view in this Tabletop window:

Fred's Cats
Music.db
Motion.db
Houses

(" concer ]
| Install




The list on the left shows databases that are currently open. You
can do one of the following:

o Select a database, then click Install. The selected database
appears in the current tabletop window.

e Click Open Other to open a database that does not appear in the
dialog box list.

¢ C(lick Empty to create a blank database and install it in your
tabletop window. The new database is essentially a template,
with no records but all the fields needed for the plots in the
tabletop window.

e (lick Cancel to close the dialog without installing a new
database in the current tabletop window.

Installing a new database works only to the extent that the field
names and types of the new database match the plots. If a field
used in a plot does not exist in the new database, the plot
component reverts to a null state (e.g., "X Axis,” or an undefined
Venn loop).
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The formula language of Tabletop is a handy tool which increases
your flexibility in building and analyzing data. The formula
language provides a repertoire of mathematical operations, from
addition and subtraction to logarithms, as well as operations for
string data and Boolean data. There are three kinds of contexts in
which you can use formulas:

e Derived or “Formula” fields. You can add a field to your
database with values that are computed automatically instead of

typed in.

e Tabletop plots. You can create Venn diagrams, Stack plots, and
Axes plots that are based on calculations defined in a formula.

¢ Tabletop window view constraint. You can use a formula to
specify a subset of the data to appear in a tabletop window.

This chapter presents some examples of how you might use
formulas in each of these contexts. You may find it helpful to
replicate the examples presented here or create similar ones of your
own.

Formula Fields A formula field looks and behaves like a regular field in your
database, except that you don't have to type in the data values for
the field. Instead, the values are computed automatically, using data
from other fields in the database, according to a formula that you
specify. For example, the cats database has information about the
body length and tail length of each cat. What about the total
length of the cat, from the tip of the nose to the end of the tail?
You can define a formula field that automatically shows the sum of
the body length and the tail length.

To make a formula field:
1. Bring the database window to the front.

2. Choose Add Field from the Database menu.

3. Type a name for your new field (Full Length is the name used
here).

4. Click and hold the field type box; choose Formula from the

menu that pops up.
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Typing a formula for the Full Length field

in a formula entry box.

The data values in the Full Length field are
filled in automatically.

5. A text editing area opens to accept your formula. Type in the
formula (in the example, the formula is 'body length’ + 'tail length").
Then click the check (V) button.

oty urith fur

full length

body lengih | tail length | eye colar | pad color | full Tength
{'body length' + 'tail length'

11 green black
12 | green pink
13 yellow black
10 green black

gray
green pink and black
15 1ysliow

11 green black
12 green pink
13 | ysliow black
10 green black

The new field is automatically filled in with computed values. Data
values in the field are kept up to date as records are changed or
added. In the cats example, try changing the body length for a cat;
its full length is automatically changed to reflect the new sum.
When you add a new cat to the database, the new cat’s full length
appears automatically, based on the tail length and body length
you enter.
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More Examples of ¢ To compare the cat data with data collected outside the United
Formula Fields States, the cats’ weights must be converted to kilograms. A
formula field KgWeight is defined with the formula weight*2.203.

e A track-and-field database includes three fields, try1, try2, and
try3, containing the distances for each of three javelin throws
by contestants. The contestants’ best throws appear in a field
called BestTry, with the formula max(tryl, try, try3).

¢ In a blind taste test of colas, each student picks a favorite from
four cups simply labeled A, B, C, and D. A database is made,
with each student’s choice in a field called CupChoice. After
the cola in each cup is revealed, a new field, ColaChoice, is
added to the database, showing which cola each student really
chose. ColaChoice can be defined by the formula:
if CupChoice is "A": "RC Cola", "B": "Coke", "C": "Star", "D": "Pepsi"

Plotting Data

Loop Plots When you specify a loop constraint by choosing a field, a relation,
and a value, you are actually composing a simple formula. Tabletop
lets you go beyond this simple formula scheme, for cases in which
the field-relation-value structure does not achieve what you want.
For example, you might want to identify contestants whose javelin
throws improved from the first try to the second.

To make a loop constraint using a formula:

1. Click and hold the first “2" box in the loop constraint. Choose
the Formula option from the menu that pops up.

2. A small text editing window opens to accept your formula.
Type in a formula that yields either true or false for each record
(in the example, the formula is Try2>Tryl). Then click the check
(V) button, or press RETURN.

The formula you entered appears in the corner of the loop. Icons
for which the formula yields true move into the loop, and those for
which the formula yields false move out.
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Formula Axes in Stack Plots
and Axes Plots
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To change the loop constraint, click and hold the formula. A menu
pops up: Choose Formula to edit the formula you entered; choose a
field name to begin defining a loop constraint using the field-
relation-value method.

Here are more situations with which you might use a loop
constraint formula:

¢ Arithmetic relationships are in the constraint. For example:
BestTry>Tryl +10 specifies those competitors who eventually
improved by more than 10 yards over their first javelin throw.

e Multiple constraints can be combined into one. For example,
gender="M" and age>12 selects older male cats in a single loop.
(Of course, you can also isolate this group of cats in the
intersection of two ordinary loops: one for males and another
for older cats.)

In both Stack plots and Axes plots, you can plot icons according to
computed values. For example, if you are looking at “fatness” of cats
in the cats database, you might begin by stacking the cats
according to their weight. But a heavy cat might not be fat — it
might be lean but very large. Perhaps a better indicator of fatness is
the ratio of weight to body length. You can plot the cats by this
ratio. To make a formula axis:

1. Click and hold the axis label. From the menu that pops up,
choose the Formula option.
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2. A text editing window opens to accept your formula. Type in
your formula (in this case: weight/'body length'); then click the
check (V) box, or press RETURN.

The formula you typed appears on the axis, and each icon is
plotted according to the value that the formula yields for it.

Z [cats with fur]l Tabletop 1 &
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To change the axis, click and hold on the axis label containing the
formula. From the menu that pops up, choose a field to plot on the
axis, or choose Formula again to edit your formula.

Here are more examples of using formulas in Stack plots and
Axes plots:

¢ In the javelin example, plot contestants according to who
improved the most from their first attempt to their last, using

the formula try3-tryl.

¢ Data for a pendulum experiment might include measurements
of string length and the number of swings completed in one
minute. Plotting length vs. number of swings shows a
nonlinear, inverse relationship. To explore the relationship
between the variables, use the formula language to plot various
functions of these raw data against each other. Plotting length
vs. 60/SwingsPerMin reveals an approximately linear relationship.

* Plot data on a logarithmic scale by simply entering log(<field>) as
the formula for an axis.




View Constraint

e With a database of numbers, Tabletop can be used as a function
grapher. The figure below shows an axes graph of a database in
which values for the field X vary from -50 to 50. With X on the
X-axis and a formula on the Y-axis, the icons arrange
themselves in classic mathematical curves.

2 [Numbers] Tabletop 1
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The View Constraint feature allows you to analyze a subset of your
database in a tabletop window. For example, if male and female
contestants are ranked separately in the javelin competition, you
might want to make plots that show contestants of one sex at a
time. To make a view constraint formula for a tabletop window:

1. Choose View Constraint from the Tabletop menu.

2. A window opens to accept your formula. Type in a formula that
yields true or false for each record (in this case, gender="F"), and

click OK.

Tabletop User's Manual



© 1995 TERC. All rights reserved.

View: Gender = F°

«f dazmine
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«f’ Natasha {f’ Mary «g’ Lednn «j‘” Soo Young

The tabletop now shows only those icons for which the formula
yields true. To edit the view constraint, choose View Constraint
again. You can edit the formula text (e.g., change it to gender="N"),
or click All to restore all icons to the tabletop.

View constraints can be useful:
¢ If you want to analyze a subset of your data in detail.

¢ If you want to compare subsets by making a series of graphs
showing different groups of data plotted the same way (as in
the javelin example).

¢ If you have a large database and would like to do exploratory
data analysis with a sample of the data, before deciding which
plots to make for the whole database.

A tip: Normally Tabletop scales each axis automatically to fit the
group of data currently visible, but you can override this behavior
by setting the axis limits of your plot manually. That way, the axes
do not change as you switch from one subgroup to the next. For
details on axis editing, see Chapter 9.

You can also view a subset of your data without typing a formula,
by selecting icons or regions in a tabletop window, then choosing
New Tabletop in the File menu. See Chapter 8 for details.
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If you haven't used Tabletop's formula language, the preceding
chapter is a good place to start. It gives many examples of
formulas in the contexts where they can be used. This chapter
describes the elements and rules that allow you to construct a
huge variety of formulas, to solve many different kinds of
problems.

Formulas are built by combining some or all of the following
elements:

e Values, such as 98.6, “north” or true

¢ Variables (i.e., database field names), such as Tail length’ or

‘GNP
e Operators, such as +, *, or, not, or contains
¢ Functions, such as max, sqrt, or log

o Selectors: If...then...else and If. . .is...

VQlueg Values in formulas are like the data values you enter in a database.
Like database values, they come in three types: number, string,
and Boolean (true/false). You can type values in formulas just as
you can enter them in a database, but there are a few differences
in how you can type them in.

Type number values as you normally would, except do not put
commas between the thousands:

Examples Incorrect
6
-15.03
208011 208,011
2.057e13

Type siring values inside double quotes:

Examples Incorrect
“green” green
“R2D2"

“What, me worry?”
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Variables

Type Boolean values as true or false. The other formats for Booleans

(T/E Yes/No, Y/N) cannot be used in formulas.

Examples Incorrect
true yes
false F

If it only allowed values and not variables, the formula language
would be no more useful than a simple calculator. The power of a
Tabletop formula comes from the fact that it is computed many
times over — at least once for each record in your database, and
again whenever data change. Each record provides a different
context for the formula, because each record may have different
data. A formula can make use of the data in a record by using field
names as variables in the formula. In the cats database the formula
‘weight*2.203 means 10.5%2.203 (yielding 23.1315) for Mittens, but
15*2.203 (yielding 33.045) for Weary.

The official way to type a variable is by enclosing the complete
field name in single quotes. However, you can often take shortcuts
to save typing. You can omit the single quotes whenever the field
name is a single word with no spaces or special characters (there
can be digits in the word, as long as they're not at the beginning),
and as long as the field name is not also a word in the formula
language (e.g., contains, max, and, number, string). You can also type an
abbreviation of a field name, as long as the abbreviation is

unambiguous.
Examples Incorrect
weight
w (short for ‘weight')
‘body length’ body length (space in name)
body (short for ‘body length’)
‘try?’ try (ambiguous among
tryl, try2, and try3)
try2
‘number’ number (reserved word)
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Operators

The formula language of Tabletop provides operators for the basic

operations of arithmetic, comparison, and logic. See the table

below.

Operator Description Example What the Example Does
+ add ‘Age’ + 10 take the value in the Age field and add 10
- subtract ‘Age’ - 10 subtract 10 from the value for Age
- change sign - ‘Entropy’ produce a positive number from a
negative one, and vice versa
/ divide ‘Area’ / ‘Population’ divide Population by Area (yielding
population density)
/ reciprocal [Frequency’ One divided by frequency
* multiply ‘Base’ * ‘Height’ multiply the base times the height
div integer division ‘Eggs’ div 12 given a number of eggs, compute how
many cartons of 12 can be completely
filled
mod remainder Year’ mod 4 compute remainder if Year is divided by
four (a result of 0 means a leap year)
A exponentiate “Radius’2 square the radius
= equal to Color’ = “yellow” true when Color is yellow and false when
Color is different than yellow
/= not equal to “Color’/="yellow” true when Color is not equal to yellow
and false when Color is yellow
> is greater than ‘Weight'>20 true when Weight is greater than 20 and
false when Weight is less than or equal
to 20
>= is greater than or ‘Weight'>=10 true when Weight is greater than or equal
equal to to 20 and false when Weight is less
than 20
< is less than ‘Weight'<20 true when Weight is less than twenty and
false when Weight is greater than or
equal to 20
<= is less than or ‘Weight' <=20 true when Weight is less than or equal
equal to to 20 and false when Weight is greater
than 20
contains substring test “Color’ contains true when Color has the letters “ish” in its
“ish” spelling (as in “greenish”)
and both sides must ‘Age’<20 and true whenever both Age is less than 20 and
be true ‘Smoker’ Smoker is true
or either side must ‘Age’<20 or true whenever either Age is less than 20 or
be true ‘Smoker’ Smoker is true (or both)
not logical negation not Smoker true whenever Smoker is false; false whenever
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Arguments and Results

Operator Precedence

Because operators work like ordinary arithmetic notation, your

intuition will usually guide you in using them. The following
technical points may be of interest, but you do not need to know
the technicalities to start using formulas successfully.

Operators accept inputs or arguments. Binary operators take one
argument on each side (as in 6 + 8, where + will compute the sum
of its two arguments, 6 and 8); unary operators take just one
argument to the right (as in /'frequency’, where / will compute the
reciprocal of its argument, 'frequency’). Operators accept
arguments of different types. The + and / operators just mentioned
accept numeric arguments. The and, or, and not operators all work on
Boolean arguments. The /= (not equal) operator accepts numeric,
string, or Boolean arguments. Operators also compute results of
different types: + and ” return numbers; = and and return Booleans.

Thinking about types, arguments, and results can help you figure
out how to fix formulas that Tabletop cannot understand. For
example, suppose you have a database of furniture and want to
make a formula field for objects that match an aquatic color
scheme. If you enter the formula color="green" or "blue", an error
message appears (“‘Formula Syntax Error”). The problem is that the
or operator requires Boolean arguments on both sides. One side is
OK: color="green" returns a Boolean. But “blue” is a string value, not a
Boolean. The or operator is not capable of solving problems like true
or "blue". To give or Boolean arguments on both sides, use this
correct formula instead: color="green" or color="blue".

How would the formula 3+4*5 be evaluated in the Tabletop formula
language? There seem to be two possibilities. The numbers 3 and 4
might be added to make 7, and then 7 and 5 multiplied to yield 35.
Or, perhaps 4 and 5 are first multiplied to produce 20, and then 3
and 20 are added to make 23. One way to be sure is to use
parentheses in the formula: (3+4)*5 clearly says to do it the first
way; 3+(4*5) specifies the second way. If you don't use parentheses,
Tabletop will rely on precedence rules to decide the order of
operations. Because * has precedence over +, in the absence of
parentheses, multiplication is executed before addition. The result
of 3+4*5 is 23.
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The following table groups operators according to their
precedence. Operators that rank higher on the table are performed
before those that rank lower. When operators are in the same
group, they are performed from left to right as they occur in the
formula.

— (unary)

A

*

[ I(unary) div mod

+

= /= > >= < <= (ontains

not

and

or

Highest precedence
(done first)

Lowest precedence
(done last)

Some of the computational abilities of Tabletop are provided in the
form of functions, rather than operators. The table below lists all
the formula language functions. To use a function, type the
function name followed by a parenthesized argument or list of
arguments, as in max('Tryl","Try2",'Try3"). Put commas between

arguments.




Function Description Example What the Example Does
min minimum Min('Tryl", 'Try2', "Try3’) return the minimum value of
Try1, Try2, and Try3
max maximum Max("Tryl", "Try2', Try3") return the maximum value of
Try1, Try2, and Try3
abs absolute value Abs('Estimate'-"Actual’) compute difference between
Estimate and Actual as a
positive number
round round to nearest integer Round('Score'/"Max"*100) convert Score to a whole
number percentage of Max
sqrt square root sqrt(‘Area’/3.14) compute the square root of area
divided by 3.14 to find the
radius
log logarithm log('GNP") compute base 10 log of GNP
log('Options',2) compute log base 2 of Options
In natural logarithm In(‘Concentration') compute log base ¢ of
Concentration
sin sine sin (‘Angle A') compute the sine of Angle A
cos cosine cos ("Angle &) compute the cosine of Angle A
tan tangent tan ("Angle A') compute the tangent of Angle A
length count characters Length('State') count how many letters it takes
in a string to spell each state’s name
concat concatenate strings concat(First’," ",'Last’) put first and last names
together, with a space in between
string convert to string concat(string(Place),"th") convert Place to a string of digits,
then add "th"
number convert to a number number(zip) convert zip from a string of digits to
a number
valid test for valid data valid('Batting Average') return false when Batting Average has
missing data or an error value
(e.g., from dividing by zero);
otherwise return true
Conditionals The conditional expressions of the formula language allow you to

specify alternative computations to be made under different

circumstances. If... Then.. Else... lets you specify two alternatives

that depend on whether a condition is true or false. If. ..Is... lets

you specify multiple alternatives based on a selector value.
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If...Then...Else... Use If... Then...Else... when you want to make a choice between
two alternative values or computations, based on a condition. Fill
in the slots as follows: If <condition> Then <choice if true> Else
<choice if false>. For example:

If “Temperature’ <= 32 Then “freeze” Else “thaw”
returns either “freeze” or “thaw”, depending on the temperature.

If “Suit’="“spades” or ‘Suit’=“clubs” Then “black” Else “red”
returns "black” when Suit is clubs or spades, and returns “red’
otherwise.

If Smoker Then ‘age™[.5+50 Else ‘age™1.2+35
applies a different formula depending on whether Smoker
(a Boolean field) is true or false.

You can also make more complicated decisions by nesting

If... Then...Else... formulas.

If ‘pH">T7 Then “base” Else If ‘pH’<7 Then “acid” Else “neutral”
returns “base”, “acid”, or “neutral” depending on pH.

If ‘age’<20 Then (If ‘gender’="F" Then “fille” Else “garcon”) Else (If ‘gender’="“F"
Then “femme” Else “homme”)

computes the French for girl, boy, woman, or man based on age
and gender. Parentheses are required around If... Then.. Else...
nested inside a Then clause.

If...ls... If.. Is... is more convenient than If... Then...Else... when you
have more than two alternatives from which to choose, and they
correspond to specific data values.

If ‘Section’ Is “front”: ‘numTickets™*22, “mezzanine”: ‘numTickets™* 14.50,
“balcony”:‘numTickets" 10

computes the price of a set of theater tickets by multiplying the
number of tickets by $18, $13.50, or $10, depending on which
section the seats are in.

If ‘Month’ Is 1:31, 2:28, 3:31, 4:30, 5:31, 6:30, 7:31, 8:31, 9:30, 10:31, 11:30,
12:31

returns the number of days in a month. If you want to handle

leap years, you can use a nested [F expression for February:
Replace 28 by (If Year’ mod 4 = 0 Then 29 Else 28).

You can add an optional Else at the end of an If.. Is..., to catch any
cases not explicitly mentioned in the list of selectors:

If ‘Month’ Is 2:28, 4:30, 6:30, 9:30, I1:30 Else 31
also computes the number of days in a month, with a little less
typing!
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